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Tosa® (Test on Software Applications)   

Tosa assessments and certifications will determine and validate a candidate’s proficiency 

and skill level in software applications used in a professional environment. Tosa 

assessments and certifications are designed to validate individuals’ digital skills (students, 

trainees, employees, or jobseekers) in supporting their employment, professional or 

academic objectives.  

Tosa assessments and certifications employ the Adaptive Testing methodology, which 

creates a personalized testing experience adapted to a candidate’s skill level for a selected 

software application. The score is based on the Item Response Theory using a 3-parameter 

logistic model, like the GMAT scoring method. Adaptive-based testing selects questions that 

challenge candidates to the limit of their knowledge and abilities.  

Tosa Skills Framework Objective 

This Tosa framework provides an overview of the subject areas being assessed during the 

Tosa Assessment and Certification exams. The Tosa validates candidate proficiency in the 

most popular professional Office software programs using a score on a scale from 0-1000 for 

the Certification Assessment, and a score divided into five levels, from “Beginner” to “Expert,” 

for the Diagnostic Assessment.  

The objective of this document is to present an overview of the technical skills associated 

with each of the four main Microsoft Excel domains within each proficiency level. This 

information will also support educators and trainers in tailoring their training program to 

achieve desired proficiency levels.  

Unique Tosa Scoring  

The Tosa assessments and certifications are based on a unique score, divided into five 

levels. 

• ranging from 1 to 1000 for the certification. 

• divided into five levels, from Beginner to Expert, for assessment. 
 

Tosa® levels 
Corresponding 
Tosa® score 

Certification status & documents issued 

Expert 876 - 1000 
Certification earned - diploma & Credly 
digital badge issued 

Advanced 726 – 875 
Certification earned - diploma & Credly 
digital badge issued 

Productive 551 – 725 
Certification earned - diploma & Credly 
digital badge issued 

Basic 351 – 550 Certification earned – diploma issued 

Beginner 1 – 350 
Certification failed - certificate of 
completion issued 
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Excel domains and subdomains 

Methods 

◼ Knowing the software environment and using the 
main functions 

◼ Using editing tools 
◼ Organizing workbooks/worksheets/tables 

Functions 

◼ Handling formulas 
◼ Using calculation functions in formulas 
◼ Identifying and inserting database calculation 

functions 

Data  
manipulation 

◼ Creating and handling graphs 
◼ Creating and editing pivot tables 
◼ Using data management features 

Formatting 

◼ Applying and handling conditional formatting 
◼ Creating, and editing digital formats 
◼ Formatting data in a workbook (formulas, texts, and 

graphs) 

About the Excel certification 

The Tosa Excel Certification relies on a database of more than 270 questions. It is composed 

of 35 questions and lasts 1 hour. The algorithm adapts to each answer of the candidates to 

adjust the difficulty level of the questions until they reach the exact definition of the 

candidates’ level by calculating the limit of their high skills. 

 

Since the test is adaptive, the series of questions that each candidate gets is unique for each 

test. This uniqueness allows for a more accurate evaluation of the candidate's level. It also 

limits cheating and the memorization of questions on different passages.  

 

Our platform allows individuals to take the certification in class, in an approved testing center, 

or remotely via our integrated asynchronous online proctoring solutions.              

 

Our remote proctoring solutions provide added flexibility for both the administrator and the 

candidate, allowing the certification exam to be taken anywhere, at any time. The candidate 

only needs an internet connection, and a computer equipped with a working webcam and 

microphone. 

 

Candidates receive a numeric score out of 1000 points associated to a proficiency level on a 

five-level scale. Candidates who score between 1 and 350 points don't earn the certification. 

They will not receive a diploma but a certificate of completion. Candidates who score 351 

points or above earn the certification. They will receive a diploma by email within five (5) 

business days. If candidates score 551 points or above, they will also be eligible to a Credly 

digital badge.   
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There is no requirement to be eligible to take the exam, but our recommendations to be well 

prepared on exam day are:  

 

- Take at least one Tosa Excel adaptive assessment to estimate your level and get 

familiar with the test format 

- Use free practice tests on our website for training 

- Follow e-learning or training courses (average duration per level is between 10 and 

15 hours per certification so around 150 hours total)  
 

Tosa certification diplomas are valid for three years from the date of issue as skill levels evolve 

or decline over time, depending on the use of the software. New software and software 

versions are released every year, and skills must be updated. We cannot legitimately certify a 

digital skills level for more than three years. Limiting the certification validity reinforces the need 

for life-long learning and professional development.  

Tosa certifications can be retaken when it is expired. Earners willing to improve their score and 

level can also retake the exam at any time. 
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Tosa Sequence for Progressive Skills Development 

Students and professionals can tailor their certification journey with Tosa, demonstrating their 

expertise in ways that align with their unique needs and goals.  

With the Tosa Microsoft Excel Certification, starting at a basic level, users can progress 

vertically, advancing to productive, advanced, and expert levels as their skills grow. This clear 

path encourages continuous improvement and validates each stage of their development. 

Tosa’s structure makes it easy to track progress and showcase evolving expertise. 

With the Tosa Microsoft Office Bundle Certification, users can expand their skill set 

horizontally across Microsoft applications, mastering interconnected applications that touch 

on a broader range of competencies. This flexible approach empowers individuals to develop 

both depth and breadth in their skillset, enhancing career prospects and workplace versatility. 

 

 

 

 



 

 

Level 1 – Beginner User 

Between 1 and 350 points 
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The Beginner Proficiency is set for a score from 1 to 350, which is the lowest Tosa score 

category. Achievement of a Beginner score defines little or limited knowledge of the Excel 

application, including the application’s basic functions and features, highlighting the inability 

to use the application in a professional environment. 

Overview 

Domains Skills Assessed 

Methods 

 

 Open a workbook 

 Save a workbook 

 Set a print area of the workbook 

 Identify the interface ribbon tabs 

 Identify rows and column names 

 Identify what are workbooks and worksheets 

 Copy and paste an image to the clipboard 
 

Functions 

 
 Enter a simple formula in a cell 
 Perform addition, subtraction, division, or multiplication in a formula 
 Identify the correct order of operations 
 Enter a time in a cell 
 Insert a SUM function 
 Recognize the ERROR symbol 

 

Formatting 

 
 Recognize a bar chart or pie chart 
 Use conditional formatting 
 Select the best chart to represent a set of data 
 Format table text with bold, italics 
 Format table color 
 Format a table with borders 
 Apply, define, and modify a cell 

 

Data 

Manipulation 

 
 Perform a simple sort 
 Filter data in a table 
 Insert a simple graphic object 

 



 

 

Level 2 – Basic User  

Between 351 and 550 points 
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Methods 

Workbook operations 

Candidates demonstrate a basic knowledge of the Excel environment; they can open the 

Excel workbook, work through columns and rows, and are familiar with the options available 

on the interface ribbon.  

Basic actions on workbooks such as “open”, “save” and “print” are competently undertaken. 

Candidates can modify a workbook and the Excel environment. They can save a file with a 

new name, set a print area, and change columns width and rows height. They can insert 

rows, columns, and cells, and can perform cut-and-paste operations. 

Business application: in a professional context, these skills allow, for example, a sales profile 

to consult and modify follow-up tables or sales action plans. 

Functions 

Calculations and formulas 

Candidates can perform simple calculations, including entering formulas. 

The Basic-User candidates can perform mathematical operations like addition, subtraction, 

multiplication, and division within a workbook and insert a time or sum in a cell. 

Candidates are expected to know common formulas such as IF, MAX, MIN, SUMIF, and 

COUNTIF. 

Business application: in a professional context, these skills allow, for example, a sales profile 

to master basic formulas (simple calculations, concatenation, percentages, etc.) to create a 

simple sales table. 

Formatting 

The Basic-User candidates are familiar with formatting that is unique to Excel, such as 

indentation of cell contents and basic number formats, and formatting that is common across 

the Office suite, such as styles, borders, background color, and font color.  

They can also use the Format Painter tool to copy formatting.  

Business application: in a professional context, these skills allow, for example, a sales profile 

to organize spreadsheets as a customer management tool by putting their data in table form, 

using sorting and filtering (simple and advanced), and exploiting tools such as "Subtotal". 

Prior to the acquisition of the skills of the Basic level, the candidate will have 

mastered the skills of the Beginner level. 
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Data Management 

Charts 

The Basic-User candidates are expected to be able to represent a data series via a simple 

chart, create a data series, and insert a line, pie, bar, or doughnut chart.  

Basic-Users can differentiate chart types and know which chart will best represent a given 

data set.  

Sorting data 

The Basic-User candidates can sort worksheet data via the Excel AutoFilter; they can filter 

data in alphabetical or non-alphabetical ascending and descending order. 

The Basic-User candidates recognize the Quick Analysis tool and know how to use it for 

simple options. 

Business application: in a professional context, these skills allow, for example, a sales profile 

to manage data to extract, sort, and classify customer data, to draw up graphs to monitor 

and/or track sales. 

Overview 

Domains Skills Assessed 

Methods 

Workbook operations:  

 Open a workbook 

 Save a worksheet 

 Print gridlines. 

 Change range names 

 Identify page layout settings 

 Change column width 

 Insert and delete a column 

 Change row height 

 Insert and delete a row 

 Insert and delete a cell 

 Save a workbook with a new name 

 Copy and move a worksheet to another workbook 

 

Functions 

Calculations and formulas:  

 Apply the MAX function 

 Apply the MIN function 

 Apply the AND function 

 Apply the OR function 
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 Apply the IF function 

 Apply the SUMIF function 

 Apply the COUNTIF function 

 Identify the difference between absolute and relative cell 

references 

 Insert a date in a cell 

 Insert headers and footers 

 Use the Trace Error button 

 Identify Common Formula Errors 

 

Formatting 

 Format cells: color, font, bolding, alignment 

 Indent formatting in cells 

 Use different styles 

 Use the Format Painter tool 

 Change the font 

 

Data 

manipulation 

Charts:  

 Create a chart in a worksheet 

 Position a chart within a worksheet  

 Identify the principal chart types: line chart, pie chart, bar 

chart, doughnut chart 

Sorting data:  

 Recognize and read a pivot table 

 Perform auto-sorting: sort in ascending/ descending order 

 



 

 

Level 3 – Productive User 

Between 551 and 725 points 
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Methods 

General knowledge 

Productive-Users can easily manipulate a large data range (more than 12 rows or columns), 

can use the shortcut keys to select and move the range, and are also familiar with the fill 

handle. They can also duplicate a worksheet and create workgroups. 

Paste Special  

The candidates are familiar with the Paste Special features, including the ability to paste 

values, transpose them and paste formats. 

Saving and printing files 

Productive-Users can save a file in PDF format and are aware of the compatibility rules 

between documents created in different versions of Excel. There is a good knowledge of the 

various print options, (printing of all or part of a worksheet). Selecting a print format (A4, 

Letter, etc.) and inserting a header or footer are demonstrated capabilities.  

Business application: in a professional context, these skills allow, for example, an accounting 

profile to establish and organize documents (closing of accounts, audits) but also to be able 

to share them regardless of the size of the documents. 

Functions 

Master calculations 

Productive-Users have good knowledge of Excel calculation methods and can distinguish 

and use absolute and relative references in formulas.  

They can also copy a cell containing a formula, know how to use text in a cell, and 

understand the principal formula errors (#NAME?, #DIV/0!, #####, etc.). 

Formulas 

The Productive-Users candidates are competent with formula writing rules and can easily 

create long formulas containing several mathematical operators and referring to multiple 

cells, recognizing simple statistical functions such as (SUM, AVERAGE, MAX, and MIN) and 

can use them easily.  

Demonstrable knowledge of conditional formulas (IF, nested IF statements, AND, OR, etc.) is 

assessed and required for Productive-Users. 

Prior to the acquisition of the skills of the Productive level, the candidate will have 
mastered the skills of the Basic level. 
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Business application: in a professional context, skills in the use of formulas (sum, average, 

percentage, ratio, calculation with dates...) allow, for example, an accountant profile to 

calculate the provision for paid vacations, establish a depreciation table, or update a 

provision. 

Formatting 

Cell formatting 

Productive-Users validate a strong ability to easily manipulate the principal cell content 

formats (text, scientific, standard, percentage, currency, date) and use numeric separators, 

merge cells, change the alignment of a cell’s contents and copy formatting.  

The candidates demonstrate a good knowledge and ability with conditional formatting and 

can apply specific formatting to high and low cell values, including spell-checking a workbook 

and applying suggested corrections. 

Creating and formatting a table 

The Productive-Users candidates can create a table from a data range and apply a table 

style.  

Inserting graphic objects 

The candidates can insert and move graphic objects such as pictures, shapes, and SmartArt. 

Business application: in a professional context, these skills enable an accountant to format a 

table and present figures to prepare a report and a dashboard from an accounting balance. 

They manage the display of databases: Freeze panes, Split, New window... 

Data Manipulation 

Chart formatting 

Productive-Users can format a chart, enlarge, or shrink it, change the colors of a represented 

data series, insert a title or legend, or edit data labels. 

Pivot tables 

Although not pivot table experts, the Productive-User candidates understand the utility and 

purpose of such tables and can recognize and analyze the data.  

Data 

The Productive-User candidates can find, replace, and select data (including selections 

based on formatting). They use data AutoFilters (numeric or text filters), in a workbook or a 

table and demonstrable knowledge of the Goal Seek function. They can extract data from a 

column using the Flash Fill tool. 
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The Productive-User candidates know how to use the Quick Analysis tool for simple options. 

Business application: in a professional context, these skills allow an accountant to use 

subtotals, sorting, filters, and logical functions such as IF, AND, and OR, to organize his 

tables. The accountant can also build a database and highlight significant facts from the 

annual accounts thanks to the creation of graphs and dynamic tables. 
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Overview 

Domains Skills assessed 

Methods 

General knowledge:  

 Customize the ribbon tabs and the toolbar 

 Split the window 

 Set a page layout 

Manipulating a large data range:  

 Select and move a cell range 

 Move and copy a worksheet 

 Work with workgroups 

Paste Special:  

 Paste and transpose values 

 Apply a mathematical operation to pasted cells 

 

Functions 

Calculation methods:  

 Identify and use relative and absolute references in a formula 

 Copy or move a formula 

 Use text in a formula 

 Know the main formula errors: #NAME?, #DIV/0!, ##### 

Functions and common formulas:  

 Create long formulas with several mathematical operators 

 Use simple statistical functions: SUM, AVERAGE, MAX, MIN 

 Use conditional formulas: IF, SI, nested IF statements, OR, AND 

 

Formatting 

 

Formatting:  

 Apply conditional formatting 

 Centre text across several columns 

 Insert SmartArt 

 Insert graphics 

 Apply a theme to a table 

 Use Flash Fill 

 Merge cells 

 Create Sparklines 

 

Data 

manipulation 
Charts:  

 Format via chart styles 
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 Resize a chart 

 Insert and modify chart titles and legends  

 Insert a chart’s data series 

 Print a chart 

Pivot tables:  

 Recognize a pivot table 

 Analyze pivot table data 

 Sort table data in a worksheet or a table 

 Find, replace, and select data (based on values or formatting) 

 Use advanced filters 

Goal Seek:  

 Know when and how to use Goal Seek 

 



 

 

Level 4 - Advanced User 

Between 726 and 875 points 
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Methods 

Customizing the environment and the display 

The Advanced-User candidates have comprehensive knowledge of the Excel environment, 

demonstrating an in-depth knowledge of Excel printing and page layout options and using 

the view (Normal, Page Layout, Page Break, Custom) that is most appropriate for the task 

being undertaken. The Advanced-User candidates validate their knowledge of the workbook 

environment and the Navigation Pane and confirm their abilities to split worksheets, 

customize the interface by creating tabs or hiding those that are less useful, including the 

display of the Developer tab and customize the Quick Access Tool Bar, as well as keyboard 

shortcuts.  

Backstage view, file formats, and file protection 

The Advanced-User candidates have advanced knowledge of the File tab, managing files, 

and their associated data, where metadata or hidden personal information can be identified 

as well as pin files to the recently used files list so that they stay visible. They can also 

demonstrate the ability to customize how files are saved, protect a worksheet or workbook, 

and password-protect a workbook.   

Task automation  

The Advanced-User candidates can automate some Excel tasks, creating and editing a 

workbook template, whilst also configuring auto-corrections to accelerate the input of 

repeating words or expressions; they can also record and run a simple macro and can create 

custom lists.  

Business application: in a professional context, these skills allow, for example, a logistics 

manager to adapt the display of tables to their needs according to their size. They can also 

use macros to automate certain tasks.   

Functions 

Calculations 

The Advanced-User candidates master all types of calculations, even the most advanced, 

demonstrating the ability to use multi-sheet and multi-workbook formulas with ease. They 

use Error Checking, Trace Precedents, Trace Dependents, Show Formulas and Evaluate 

Formulas features. They can also competently use Name Manager to manage the names of 

cell ranges. 

Prior to the acquisition of the skills of the Advanced level, the candidate will have 

mastered the skills of the Productive level. 
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Functions 

The Advanced-User candidates have advanced knowledge of formulas and functions. They 

use the Function Library to access complex functions and view their syntax. The Advanced-

Users master mathematical functions such as ROUND or INT and display a good 

understanding of advanced search functions such as INDEX and MATCH, possessing 

excellent knowledge of text functions, especially LEFT, RIGHT, and MID, the search 

functions REPLACE and REPLACED, date functions (TODAY, DAY, MONTH, WEEKDAY, 

etc.), time functions.  

They can perform calculations based on dates, count occurrences of a number or text in a 

range (COUNTIF), generate random numbers (RAND), rank a number (RANK), and perform 

simple search functions (VLOOKUP, HLOOKUP); CONCATENATE.  

Database calculations 

The Advanced-User candidates are highly competent in database calculations and database 

functions such as DCOUNT, DCOUNTA DSUM, DAVERAGE, DMAX, DMIN, COUNTIFS, 

SUMIFS, AVERAGEIFS, displaying the ability to return a subtotal in a list or data range 

(SUBTOTAL). They are also familiar with the SUMPRODUCT function and create array 

formulas. 

Business application: in a professional context, the use of complex formulas allows, for 

example, a logistics manager to control stocks and analyze sales.   

Formatting 

Formatting and page layout 

The Advanced-User candidates master formatting and page layout tools, configuring auto-

formatting as well as conditional formatting. They display efficient use of workbook themes, 

margin changes, and orientation of a worksheet, manage page breaks and insert a 

background, footers, and headers. 

Excel graphic objects 

The Advanced-User candidates can insert and manage Excel graphic objects, pictures, 

SmartArt, shapes, or screenshots and can insert objects from other Office applications such 

as Word or PowerPoint. They display a good knowledge of how to use the Selection Pane, 

format graphic objects (color, shape, indentation, fill), modify shapes, and reorganize objects 

(bring forward, send backward, align, group, ungroup). 

Business application: in a professional context, these skills allow, for example, a logistics 

manager to use Excel formatting tools to monitor the consumption of specific customer 

markets, convert the data in his tables into graphs, or monitor the invoices of suppliers. 
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Data Manipulation 

Extended tables and databases 

The Advanced-User candidates can manage large tables and databases, use advanced 

sort/filter functions, and can perform multi-criteria / customized sorting, and use complex 

filters to extract data. They also display a strong competence in defining table style options 

(header row, total row, striped rows, columns, first column, last column). They also know how 

to use segments to apply filters. 

Chart analysis 

The Advanced-User candidates are familiar with advanced chart tools and the full range of 

chart templates including advanced charts. They can perform advanced editing of charts, 

such as overlaying charts and changing axis units, using a secondary axis incorporating the 

use of trend lines. 

Pivot table creation and analysis 

The Advanced-User candidates master the analysis and creation of pivot tables, generating 

pivot tables from a database, manipulating various data sets, updating pivot table data, and 

formatting pivot tables. 

Quick Analysis Button 

Advanced-Users know how to use the Quick Analysis thoroughly. 

Business application: in a professional context, these skills allow, for example, a logistics 

manager to anticipate future consumption, transmit supply needs to the purchasing manager, 

and manage stocks. 

Overview 

Domains Skills assessed 

Methods 

Customizing the Excel display:  

 Display the Developer tab 

Managing backstage view, file formats, and protection:  

 Recover an earlier version of a workbook 

 Know file formats 

 Protect a worksheet or workbook 

 Insert an electronic signature 

 Customize the Quick Access toolbar 

Automating Excel tasks:  

 Run recorded macros 
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Functions 

 
Calculations, functions, and database calculations: 

 Use multi-sheet and multi-workbook formulas 

 Edit a formula 

 Create calculations based on dates 

 Use mathematical functions (ROUND, INT) 

 Use advanced search/lookup functions (INDEX, MATCH) 

 Use text functions (LEFT, RIGHT, MID, EXACT, etc.) 

 Use REPLACE and REPLACEB 

 Use Date functions (TODAY, DAY, MONTH, WEEKDAY) 

 Use Time functions 

 Count occurrences of a number or text in a range (COUNTIF) 

 Generate random numbers (RAND) 

 Rank a number (RANK) 

 Use search functions (VLOOKUP, HLOOKUP) 

 Use CONCATENATE database functions (DCOUNT, 

DCONTA, DSUM, DAVERAGE, DMAX, DMIN, COUNTIFS, 

SUMIFS.) 

 Return a subtotal in a list or data range 

 Use of array functions (SUMPRODUCT) and array formulas 

 Edit links 

 Create formulas with AVERAGEIF functions 

 Create formulas with DAVERAGE functions 

 Use Name manager advanced options 

 Use formula-error checking 

 Evaluate formulas  

Formatting 

Formatting and page layout:  

 Insert a screenshot 

 Master Selection pane 

 Display cell contents in a shape    

 Insert symbols / Insert Special characters 

Graphic objects:  

 Arrange objects 

 Apply advanced manipulation of graphic objects 

 Insert Form Controls 
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Data 

Manipulation 

 

Tables and databases:  

 Use slicers 

 Master Goal Seek 

 Master data consolidation 

 Complete multi-criteria sort 

 Complete customized sorts 

 Use complex filters to extract data 

 Convert an excel table data range 

 Create and edit a drop-down list 

 Use Data Validation tool 

Chart manipulation:  

 Create complex charts 

 Master formatting graphic objects 

 Master graph overlays 

 Add secondary axis and trend lines 

Pivot table creation and analysis:  

 Create pivot tables 

 Manage pivot tables 

 Use advanced filters 

 Format pivot table 

 Select, copy, move and delete pivot tables 

 Insert a timeline 

 Remove duplicates 

 
 

 



 

Level 5 – Expert User  

Between 876 and 1000 points 
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Methods 

Customization and automation of the Excel environment 

The Expert-User candidates possess complete mastery of the Excel environment: all tabs 

and their associated functions, including the Data, Formula, and Developer tabs. They are 

familiar with all Excel views and can link worksheets within a workgroup and can save 

workbooks in an arranged workspace.  

Expert-Users can customize the Excel environment, including the Backstage view option, the 

Quick Access Toolbar, or the Excel ribbon tabs. They are familiar with the various Save / 

AutoSave options and printing options such as printing in color or printing several pages on a 

single sheet. They possess expert knowledge of the Developer tab, can create complex 

macros, and have complete knowledge of file extensions. 

Data review and sharing 

The Expert-User candidates master the Excel functions associated with the exchange, 

protection, and review of data. They can import external data, view the connections to 

external data, and can update data as well as export and share it.  

The Expert-User candidates fully understand all the options for protecting the workbook, 

protecting cells, sheets/workbooks, and allow or disallow modifications to a workbook. They 

display expert competency in the Review tab functions, such as translating sections of a 

workbook as well as inserting, deleting, and managing comments. 

Business application: in a professional context, these skills allow, for example, a financial 

analyst to perfectly organize their files and their contents to be able to modify them and keep 

them in the appropriate format.  

At this level, the candidate can train on the software. 

Functions 

Calculation methods 

The Expert-User candidates have comprehensive knowledge of calculation methods using 

the advanced Name Manager Options and formula auditing features such as Error Checking 

and Evaluate Formula. They can use the Watch window and Calculation Options. 

Writing and decoding complex formulas 

The Expert-User candidates display expert competency in Excel formulas displaying 

application knowledge with array functions such as (INDEX, MATCH, OFFSET, etc.), 

Prior to the acquisition of the skills of the Expert level, the candidate will have mastered 

the skills of the Advanced level. 
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information functions (ISNA, ISNUMBER, ISBLANK, etc.), financial functions (PMT, NPER, 

RATE, etc.) and advanced date functions (NETWORKDAYS, WORKDAY, DATEDIF, etc.). 

They possess expert knowledge of the function library and can browse the library for new 

functions. 

Business application: in a professional context, the use of specific complex formulas (INDEX, 

EQUIV, VPM(), NPM(), DATEDIF(), etc.) allow, for example, a financial analyst profile to 

analyze company balance sheets, to carry out comparative analyses of data or to establish 

in-depth studies in the event of a takeover or sale.  

At this level, the candidate can train on the software. 

Formatting 

Editing and formatting 

The Expert-User candidates master all the workbook formatting and editing tools and are 

thoroughly familiar with the numerous cell formats, presenting data as a map. They can 

Group and Ungroup data and insert subtotals via the Subtotal button, show or hide data 

elements, insert hyperlinks in a worksheet, and can also create custom lists. 

Creating and editing forms 

Expert-Users can create and edit forms, and insert form controls and ActiveX controls via the 

Developer tab.  

Business application: in a professional context, mastery of Excel formatting tools allows, for 

example, a financial analyst to interpret the value of the company or to analyze the 

company's balance sheets, as well as to collect financial and economic information and 

format it. 

At this level, the candidate can train on the software. 

Data Manipulation 

Calculation analysis and simulation 

The Expert-User candidates master advanced data analysis tools such as data conversion 

and AutoFill. They can use the Remove Duplicates, Data Validation and Scenario Manager, 

and Solver tools. 

Pivot tables 

The Expert-User candidates master the creation and analysis of pivot tables, displaying a 

thorough knowledge of pivot table tools and options and can manipulate all types of data. 

They can show totals and subtotals, use summary functions, and are also thoroughly familiar 

with pivot table formatting, generating pivot tables, and the various ways to update pivot 

tables data.  
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Graphic analysis of data 

The Expert-User candidates possess expert knowledge of chart types and know how best to 

present them including competent chart formatting and editing.  They can easily edit data 

sources, manage chart axes and data labels, and can create complex charts such as a 

pyramid or Ombrothermic diagrams, and insert and customize Sparklines. 

Business application: in a professional context, these skills allow, for example, a financial 

analyst to present data in the form of pivot tables or graphs. They choose the appropriate 

graph according to the nature of the data to be used.  

At this level, the candidate can train on the software. 
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Overview 

Domains Skills assessed 

Methods 

Excel customization and automation:  

 Customize the Excel environment 

 Encrypt a workbook    

 Share/distribute a workbook 

Data review and sharing:  

 Convert a table to a normal range and subtotal-related data 

 Import Data form 

 

 
Functions 

Calculations:  

 Use the Watch window 

 Use calculation options 

 Use worksheet calculation functions 

Generating and decrypting complex formulas: 

 Master complex array functions (INDEX, MATCH, OFFSET, etc.) 

 Master information functions (ISNA, ISNUMBER, ISBLANK, etc.) 

 Master financial functions (PMT, NPR, RATE, etc.) 

 Use advanced date functions (NETWORKDAYS, WORKDAY, 

DATEDIF, etc.) 

 Master the function library 
  

Formatting 

Formatting tools and editing forms:  

 Insert form controls 

 Insert ActiveX controls 

 Insert hypertext links 

 Use custom lists 

 Use Name Manager advanced features 

 Master Paste Special options 

 Customize Sparklines 

 

Data 
Manipulation 

Calculation analysis and simulation:  

 Create a table of assumptions 

 Master Scenario Manager 

 Master the Solver tool: target and adjustable cells, constraints, 

results 
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Pivot tables:  

 Comprehensive knowledge of pivot tables 

 Use of totals and subtotals in pivot tables 

 Update data in pivot tables 

 Create and manage pivot table charts 

 Format of a pivot table 

Graphical data analysis: 

 Read graphic analysis of data  

 Apply data validation to cells 

 Insert and customize sparklines 

 Create pyramids 

 Create ombrothermic diagrams 
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